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1.​ Device Description 

1.1​ Intended Purpose 

The ERPrec is a software device that can be used for diagnostic purposes based on 
event-related potentials (ERPs) or electroencephalogram (EEG) signals.  
 
The software is intended to  be used in conjunction with compatible hardware, such as the EEG 
NeuroAmp (x23, x39), appropriate set of electrodes (including EEG Caps), Combination Sensor 
and ERP Sync as well as appropriate computer systems. 

 

1.2​ Medical Contraindications and Medical Indications 

The device is intended for: 
Recording and storing electroencephalogram (EEG) and event-related potential (ERP) 
and other bio signals intended for taking decisions with diagnosis or therapeutic 
purposes. It is not intended for specific medical conditions.  
The presentation of stimuli for ERP recordings. 

Contraindications 

There are no contraindications.  

1.3​ Intended Use 

The device can be used for diagnostic purposes based on event-related potentials 
(ERPs) or electroencephalogram (EEG) signals. 
 
The device is intended for: 
Recording and storing electroencephalogram (EEG) and event-related potential (ERP) 
and other bio signals that can be used for diagnostic purposes. It is not intended for 
specific medical conditions.  

1.3.1​ Intended Patient Population 

The software is suitable for use in patients that may benefit from diagnostic EEG/ERP 
assessments, including both adults and children. 

1.3.2​ Intended User Group and User Profile 

The device is intended to be used by healthcare professionals. 

1.3.3​ Medical Context of Use 

Intended place of operation 

The software is intended for use in clinical settings, including hospitals, clinics, and 
specialized medical facilities. It is also intended to be used in home care environments. 
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Intended use environment 

The software is intended to be used in professional healthcare facilities as well as in 
home use environments. 

Intended duration and intended frequency of use 

For ERP analysis the intended duration is 30 minutes for acquisition of EEG recording. 

1.3.4​ Non-medical Context of Use 

Compatibilities 

The software must be used in conjunction with compatible hardware as listed in 1.11 
Description of Accessories and Consumables. 

1.4​ Product Lifetime 

The device can be used for at least 2 years without changing the hardware settings or 
operating system. 

1.5​ Claims 

Technical Claims 
 

●​ The software ensures robust, high-resolution recording of multi-channel EEG data, 
objectively measurable through defined resolution, filtering, and impedance 
monitoring. 

●​ The software accurately executes specific ERP paradigms and ensures extremely 
low-latency, low-jitter synchronization between stimulus presentation and data 
registration to prevent signal distortion. 

Indirect Clinical Benefit 

●​ By providing a synchronized and technically validated raw data foundation, the 
software reliably enables subsequent neurophysiological assessments and diagnostics 
by the physician. 

1.6​ Risks 

All risks are covered in the Risk Analysis, there are no residual risks that patients or 
users need to be informed about.  

1.7​ Side-effects 

There are no side and adverse effects, complications and known clinical risks in the 
sense of unavoidable effects that come with the use of the device.  

 



 

1.8​ Software-related Safety Information 

1.8.1​ Safety Instructions 

 

WARNING 

 

Denotes a probably dangerous situatio
that may lead to severe injury or death

 

CAUTION 

 

Denotes a probably dangerous situatio
that may lead to injury 

 

CAUTION 

 

Denotes a situation that could lead to 
damage of the product 

 

NOTICE 

 

Warning symbol for situations that do 
not lead to death, injury or damage of 
property 

The meaning of the symbols on the package label of the ERPrec: 
 

 
 Conformity symbol 

 Product name and model,  

article number if applicable 

 

Manufacturer 

 

Date of manufacture: Release Date 

 Consult instructions for use 

eIFU available online web address: 

ifu.beemedic.com/erprec 

 

 UDI Symbol 

 (01) UDI Number 
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(11) Release Date 

(8012) Version number 

 

Medical device 

 

1.8.2​ Guidelines for Use 

Please take the time to read this manual carefully before using the software for the first time in order to 
familiarize you with its operation. This manual is part of the product and must be available anytime. Use the 
software only for the intended purpose (see section 1.1).  

The ERPrec software may only be used by a professional who can ensure sound handling practices. 

 

NOTICE 

Erroneous EEG signals possible if frequent data transmission errors occur 
The 'Sync Error' light should not flash frequently and the error count should never go beyond 100 
during a session,  
●​Make sure that the minimum system requirements are met 
●​Check the USB Cable 
●​Do not run software that requires high CPU power such as virus scans or internet telephony while 

running ERPrec. 
●​In case you are not sure about the Sync Error display, contact us 

 

 
 

NOTICE 

Erroneous EEG signals possible if frequent data processing errors occur 
The 'Proc Error' or 'Sync Error' counters should stay near zero during a session. If one counter goes 
beyond ten, a serious error may have occurred and it is advised to restart the software.  
●​Make sure that the minimum system requirements are met 
●​Do not run software that requires high CPU power such as virus scans or internet telephony while 

running ERPrec. 
●​In case you are not sure about the Proc Error display, contact us 

 

 
 

NOTICE 

ERPrec may not run if graphics settings are improper 
●​Direct X must be installed and activated.  
●​Hardware acceleration must be enabled. 

 
 

NOTICE 

ERPrec may not work if other graphics intensive applications are running 
●​Do not run software at the same time as ERPrec that makes heavy use of the graphics adapter 

such as Google Earth.  

 
 



 

NOTICE 

Unauthorized access 
●​We recommend a password protection for your computer in order to prevent unauthorized 

access.  

1.9​ Principles of Operation 

The device will be launched by choosing and starting the device. It starts communicating and 
verifying if the attached hardware accessories are compatible and licensed. 

 

Figure 1: Equipment 

For diagnostic purposes based on event-related potentials (ERPs) or 
electroencephalogram (EEG) or other bio signals the module ERPrec receives these 
signals from the hardware accessories and connected EEG electrodes (see Figure 1). 
The signals will be acquired, pre-processed, visualized on the clinician’s screen and 
stored within a local database. In case of an event related potential (ERP) recording, 
the ERP task is presented to the client on a client’s screen. The Sync-Box is connected 
to the second screen to record a visual signal for task presentation synchronization and 
to the audio output. An event button is connected to the Sync-Box to align the clients’ 
reaction to the presented tasks. The following figure (see Figure 2) shows a schematic 
of the whole system with all connections: 
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Figure 2: Schematic of the EEG setting with all connections 

 

With the visualized results simple patient records can be used to create reports for 
other clinicians. 

The device can store rudimentary patient and user information that can be used to 
create the patient reports for different use cases. 

 

1.9.1​ Description of Inputs 

 

Depending on the accessories and modules used, the following input signals can be 
processed by the device: 

●​ 19-39 channel EEG signals 
●​ heart rate 
●​ galvanic skin response (GSR) 
●​ skin temperature of the finger can be measured (not absolute values, only 

trends) 
●​ input-events from client (for ERP measurement) 

 

1.9.2​ Description of  Outputs 

The device can display and process the recorded EEG signals and other biosignals. In 
the case of ERP recordings, the recorded ERPs can be provided in the form of 
graphically synchronized figures.  

The device provides channels to provide auditive and visual stimuli to the patient for 
the purpose of recording ERPs. 



 

1.9.3​ Description of Functional Units 

ERPrec consists of the following packages that work together: 

●​ ERPrec signal core 
●​ Real-time task presentation engine 
●​ Converter to WinEEG, MATLAB and more 

Figure 3 shows a basic block diagram of the ERPrec software structure.  

 

Figure 3: Functional Units of the ERPrec Software 

 

 

Figure 4: Data flow of the ERPrec software 
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1.10​ Description of Configuration 

There are no variants: 

Device UDI-DI Description 

ERPrec 4262418760051 Recording module for facilitating diagnostic 
evaluations based on event-related potentials 
(ERPs) or electroencephalogram (EEG) signals 

 

1.11​ Description of Accessories 

 

Device UDI-DI Manufacturer 

EEG NeuroAmp II.5s 4262418760112 BEE Medic GmbH 

EEG NeuroAmp II.5s 04251341900023 Corscience GmbH & Co. KG 

Combination Sensor 4262418760006 BEE Medic GmbH 

Combination Sensor 04251341900061 Corscience GmbH & Co. KG 

NeuroAmp x23 4262418760099 BEE Medic GmbH 

NeuroAmp x23 04251341900078 Corscience GmbH & Co. KG 

NeuroAmp x39 4262418760105 BEE Medic GmbH 

NeuroAmp x39 04251341900085 Corscience GmbH & Co. KG 

ERP Sync 4262418760082 BEE Medic GmbH 

ERP Sync (Sync-Box) 04251341900092 Corscience GmbH & Co. KG 

EEG Cap/ set of electrodes various various 

 

In addition to the accessories mentioned above, other devices may be required as 
standard IT infrastructure, such as additional screens, speakers or headphones. 

 

1.12​ Description of Compatibilities 

For additional screens all modern computer screens can be used. To ensure 
compatibility the resolution must be more than 1080p and a frame rate of at least 
60Hz. 

1.13​ Innovative Features of the Device and Innovative Medical Procedures 

There are no innovative features implemented and the device does not use any 
innovative medical procedures.  

 



 

 

 

2.​ Installation 

2.1.​ Minimum System Requirements 

 

CAUTION 

●​Make sure that the minimum system requirements are met 
●​Do not run software that requires high CPU power such as virus scans or internet telephony 

during a QEEG recording with ERPrec. 

 

Product Lifetime 

The software can be used for at least 2 years without changing the hardware 

settings or operating system. 

 

Recommended Computer Configuration: 

●​ 2 GHz Dual Core processor or greater​
Notice: We strongly recommend an Intel i5 or i7 processor, because ERPrec runs better on these 
than on other processors.  

●​ 16 GB RAM  

●​ Operating system: Windows 10 or 11 

●​ Sound card 

●​ NVIDIA or AMD (trade name ATI) graphics processor with 3D acceleration and 1 GB of dedicated 
video RAM. Dual Monitor support, VSync support​
Note: Integrated video systems that share system memory with the processor are not supported.  

Note: The computer may be battery- or line powered; galvanic isolation is provided by the digitizing device. 

 

Please ensure that appropriate antivirus software and firewall configurations are active to protect the 
integrity of the system and its data.  

Note: Only Windows Defender or Norton Antivirus are supported. 

During the installation process, your antivirus software may cause technical interference. If you 
encounter issues during setup, please temporarily disable the antivirus software. (This specifically 
applies to known compatibility issues with Norton during the installation phase). Remember to 
reactivate the software immediately after the installation is complete. 

 

Monitor Specifications: 

Primary Monitor (for use by clinician) 
1366 x 768 minimum resolution 
 
Secondary Monitor (to display visual ERP stimuli to the client)​
1024 x 768 minimum resolution​
 
Maximum resolution may be limited by the size and power of the video card selected. Consider increasing the computer 
specs beyond those shown above when working with larger, higher resolution screens and TVs including 720p,1080i, or 
1080p resolution. When purchasing a high-end flat screen TV or monitor, make sure lower resolutions are 
also supported such as 720p or lower.  
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Connectors for secondary monitor: 15 pin D-Sub VGA or HDMI recommended. Component video connectors can be 
used with the help of an adaptor. 

 

 WARNING 

To guarantee the patient’s safety, peripheral devices, such as the computer are to be operated 
outside of the patient’s immediate surroundings, i.e. at a minimum distance of 1.5 m from the 
patient. If this distance should not be able to be kept, then measures must be taken to reduce the 
housing leakage current. This must be done in accordance with the requirements of IEC 60601-1-1. 

 

2.2.​ Installing the ERPrec Software 

Locate the installation file named “ERPrec_2.0.8.X.exe" and double-click on the file. 

At first, the installer will offer to guide through the installation process. The ERPrec software interface 
language can be chosen by a dropdown menu. 

 

 

 

Press “OK”, the installation wizard will start with this dialog: 

 

 

 



 

Press "Next" and accept the license agreement. After the license agreement, the installer will ask you to 
choose the folder on your computer, where the software is going to be installed. Then you will be asked for 
the option to add an icon on the desktop as well as in the Quick Launch bar. It is recommended to have 
these icons installed and not to change the checkboxes in the dialog. 

 

After pressing "Next", the installer will show a summary of the selected options and show a button "Install". 
Press this button to start the installation. 

If no NeuroAmp is connected to the PC, the installer will ask you to connect one. 

 
 
Connect your NeuroAmp and press “OK” to continue the installation. 
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If you press “Cancel” the ERPrec installation will be cancelled. 
 

 

 



 

After this, the following window will appear: 

 

 

The NeuroAmp driver is pre-installed. After installing ERPrec, connect your NeuroAmp to a USB-port of your 
computer and Windows will automatically install the driver. In case this does not work, please install the 
driver manually via the device manager (s. NeuroAmp manual).  

 

 

Notice 

The ERPrec installer may install third party software. If you notice that the installation window does 
not react, check for other running installers (task bar icons) that might require user interactions.  
 

 

 If you have difficulties downloading, installing or starting the ERPrec software, please contact us. 
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2.3.​ Install the MATLAB Run-Time Software 

If conversions to the WinEEG or HBIdb software format shall be performed, the MATLAB Runtime will be 
needed. Install "MCRInstaller.exe", which is not part of the package but can be obtained from the same 
source as ERPrec. 

 

2.4.​ Initial Startup 

Make sure that the NeuroAmp/x23/x39 is connected to your PC before you start ERPrec.  

ERPrec may now be started from the start menu, or, if installed before, via shortcuts on the desktop or quick 
launch bar.  

If your computer has a firewall software enabled, it may ask you once if you want to allow ERPrec to access 
the network. You must allow this application to access the network!  

Otherwise you will not be able to create and modify client ID cards. 

 

 

 

Figure 3: Example: Security alert of the Windows-Firewall 

 

Check the proper function of the ERPrec software before each session by starting a session. The EEG 
display of the therapist screen must show an EEG signal and the timer must start running. 

 



 

3.​ Initial Set-Up 

3.1.​ System Set-up Overview 

ERPrec allows for ultra-precise ERP recordings. To achieve the precision, the visual and auditive stimuli are 
being recorded together with the EEG. Therefore, the "Sync-Box" needs to be attached to the bottom corner 
of the stimulus screen. 

 

Figure 4: ERP recording set-up 

Refer to the NeuroAmp ERP Sync manual for details. Figure 4 shows the required wiring of the system. 

 

3.2.​ Step-by-step Hardware Set-up 

In order to wire up the system correctly, the next steps need to be performed. 

1)​ Install ERPrec software to the therapist PC according to Section 5.2 

2)​ Connect the NeuroAmp to the PC with the attached USB cable. If plugged in correctly, the 
NeuroAmp responds with a “beep”. 
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3)​ If applicable, connect the X23 device to the NeuroAmp 

 

 

 

4)​ Next, you need to connect the Sync-Box according to the following steps: 



 

 

a) Mouse for client, permanently connected, no action needed 

b) Data connection to NeuroAmp(Mini-Din8 connector). 

 

c) Audio signal to speakers 

d) Audio output signal from PC to Sync-Box (most likely named “Headphones” or “Speakers” at 
the PC side) 

 

5)​ Now attach the Sync-box to the lower right corner of the patients’ screen (see Figure 2) 

 

Now you are ready to adjust the settings for ERPrec and to perform the first hardware test. 

Note: The audio signal from the PC is used for synchronization in the Sync-box and then re-routed to the 
output “c” to connect it to a speaker / sound system. 

3.3.​ Set-up file ERP.xml 

Before the ERP engine can be started, a couple of initial manual settings are required. Reason for not 
automating them is the fact that reading the values from the Windows operating system proved not reliable 
enough. 
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In this step, the file "C:\Program Files (x86)\ERPrec\ERP\erp.xml" is to be manually edited. If you have 
changed the default installation path of ERPrec, you find the file in your main installation path 
ERPrec\ERP\erp.xml: 

The ERPrec software writes to this file and the Real-time engine reads values from it. Some settings shall be 
aligned by the user (see *). Most important settings are *3), *4) and *7): 

 

<Configuration> 

 <path>vcpt</path> folder (within ERP) of task to be started  

 <script>vcpt.pro</script> task script to be executed  

 <start_task>0</start_task> start with this task *1) 

 <do_mode>resume</do_mode> mode of the engine to be started  

 <sound_delay>-90.1</sound_delay> automatically inserted by calibration routine  

 <shift_audio_to_earlier>0</shift_audio_to_earlier> manual correction value *2) 

 <calcycle>500</calcycle> period of calibration cycle  

 <t_off>300</t_off> length of audio/video calibration pause  

 <msize_x>1920</msize_x> pixel numbers of second monitor width setting *3) 

 <msize_y>1080</msize_y>  pixel numbers of second monitor height setting *3) 

 <forcefps>60</forcefps> force a specific frame rate. 0 = Auto-Set *4) 

 <rel_box_size_x>100</rel_box_size_x> relative width of black synchronization field *5) 

 <rel_box_size_y>100</rel_box_size_y>  relative height of black synchronization field *5) 

 <stim_debug_box>0</stim_debug_box> add a sub-box that shows the presence of stimuli  

 <auto_calibrate>1</auto_calibrate> set if auto-calibrate shall be performed *6) 

 <practice_test>1</practice_test> default for checkbox in CPT selector  

 <th_audio>0.10</th_audio> audio detection threshold  

 <th_video>0.10</th_video>  video detection threshold  

 <th_image>0.10</th_image>  image detection threshold (only with extra sensor)  

 <th_stdev>5.00</th_stdev>  Auto-setup threshold: standard deviations  

 <actual_screen_width>34</actual_screen_width> width of stimulus screen *7) 

 <actual_screen_distance>150</actual_screen_distance>  distance from stimulus screen  

 <pause_aborts_trial>0</pause_aborts_trial>   

</Configuration>   

 

 

The settings marked with an * above may be modified by the user: 

1)​ start_task: the CPT real-time engine will start with the trial number given here. This setting defaults 

to 0, but can be set to force the engine to start with a different trial, e.g. to resume a session 

broken up by a crash. Usually 0. 

2)​ shift_audio_to_earlier: if the auto-calibration shall be shifted by a fixed value, the number in ms 

can be set here. Usually 0 

3)​ msize_x and y: pixel resolution of the second monitor. Set the values of the actual Windows 

setting. Reason for this manual setting is that Windows does not provide reliable enough 

information about the second screen resolution. One may also force the second screen to a 

resolution different from the set resolution. That, however, is not recommended. To find the 

resolution right-click on the Desktop of the second screen. A menu will appear where you can find 

“display settings”. 



 

 
 

4)​ forcefps: force a specific frame rate. 0 = Auto-Set = default. Set to 60. 

5)​ rel_box_size_x and y: modify the size of the black synchronization field such that it hides behind 

the Sync-Box device � this can be done here or via the calibration dialog explained in the next 

section. 

6)​ auto_calibrate: defaults to 1, which means that the engine performs an automatic calibration prior 

to each CPT. If the automatic calibration shall not take place, e.g. because the system turned out to 

be stable, then this value can be set to 0. If not sure, leave it at 1. 

7)​ For many tasks the size of the monitor which presents the visual stimuli and the distance to the 

subject is specified. If the test environment uses different parameters, the stimulus image size 

needs to be modified to match the specification.  

For instance, the specification for the VCPT used for the HBI database is a 17" 4:3 monitor viewed 
at from a 1.5m distance. 
If a patient sits in front of a 32" monitor in 2m distance, the image has to be scaled down to match 
the specification. 
For this purpose, the specified screen width and distance can be entered in the task definition file 
task.xml, which resides in each task folder, by means of these tags: 
​ <stimulus_image_size_auto>1</stimulus_image_size_auto> 
​ <specified_screen_width>34</specified_screen_width> 
​ <specified_screen_distance>150</specified_screen_distance> 
The first can be 1 or 0. 1 means that the size of the image shall be adjusted to match the 
specification. The two other parameters define screen width and distance in cm. If an angle is 
defined, one value may be entered arbitrarily and the other calculated from it. 
If stimulus_image_size_auto is 0, then the stimulus images will be maximized to the screen by 
keeping the aspect ratio. 

 

3.4.​ Step-by-step procedure for initial calibration 

The following procedure shall be performed initially to check if the system is ready for use. In the case of 
trouble shooting, more details about the calibration process are given in Section 5.1 All steps including 
3.2 need to be performed before following the steps below. 
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An important note before we start with the calibration: 

The real-time engine comes with a limitation that impairs the usability in the current release: keyboard and 
mouse are taken over exclusively by the engine. 

To be able to pause a session and interact with other programs, follow these steps: 

-​ as long as calibration or ERP stimulus presentation is ongoing and visible, the computer does NOT react 
to any input.  

-​ if you want to pause a CPT, do this: press p 

-​ if you want to go to the other programs, press alt-tab. Now the computer can be used as usual 

-​ to go back to the CPT, press on the little round white icon in the task bar 

then, press <enter> to continue the CPT 

Why all this hassle? The reason is that the CPT presentation is super-precise and does not allow any user 
interaction while running. 

In case you need to cancel calibration or a CPT, then press ctrl-q (stops everything) 

 

 

 

Step Task Comment 

1 Enable video 
frame sync 

Go to graphics adapter setting, usually found in the "3D" settings. Here, the "V-Sync" has to 
be enabled. 

2 Edit ERP.xml According to 3.3  

3 Start 
measurement 

Klick on the “start” button in main window: 

 

 

Signal traces should appear in the main window. 

4 Start ERPrec 
and open 
self-test set-up 
window 

Start ERPrec, Open Settings -> Self-test set-up menu item. 

 

 

5 Initial 
calibration 

 

 

1)​ Press “Cal Mode” 2)​ Press “Start Engine in CAL Mode” 



 

  

6 Calibration 
Check 

 

The real-time 
engine takes 
over control of 
the PC.  

The therapist 
screen should 
show: 

 

-green Audio 

-green Video 

-std-dev   
below 
threshold  

 

 The main 
window 
indicates this 
mode by 
“calibrating…” 
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7 Finish first 
Check 

 

ERPrecwill 
return to 
initial program 
start 

To finish the initial calibration check, press ctrl-q 

 

The initial calibration check gives a good indication if the hardware is routed correctly and if the audio, 
video and standard deviation signals are in the correct range for using ERPrec. 

To ensure valid ERP measurements, a similar self-test will be performed prior to each session 
automatically. This is described in Section 4.3.1  

 



 

  

4.​ Using ERPrec 

4.1.​ Overview 

ERPrec has a simple and clean display. The most frequently used functions are accessible through the Quick 
Launch bar: 

1)​ Starting the EEG, record a Session, starting an ERP Task, … 

The adjustable EEG Display can either show all 19 or only 1 EEG channel. Its Filters can be quickly modified 
via the Quick Launch Bar as well. 

ERPrec also controls your EEG amplifier – you don’t need to manually switch it on or off. 

 

 

Figure 5: Graphical user interface of the ERPrec software 

 

4.2.​ Getting started (EEG Monitoring) 

After starting ERPrec you can start, pause and stop the EEG signal via the Control bar or the ERPrec menu. 

These controls do also control your EEG amplifier - you do not have to switch the amplifier on or off 
manually. 
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Menu Quick Launch Bar Description 

 

 

Start / Pause. Also turns on EEG 
NeuroAmp/x23/x39 

 

Pause / Start. Does not stop recording, if selected
and does not turn off EEG NeuroAmp/x23/x39. Ju
halts the session until Pause is pressed again 

 

Stop. Turns off EEG NeuroAmp, stops recording, if
selected, and stops all ​
processing 

Figure 6: Starting, Pausing and Stopping the EEG 

 

Starting the EEG will also start the Session Timer in the Display Control- and Information Bar. 

 

 

 

Figure 7: Session Time Display 

 

The Timer will pause if you pause the EEG and will be reset after stopping the EEG signal. 

 

4.2.1.​ EEG Display 

The EEG Display does either show all 19 EEG Channels or only one out of the 19 channels. This can be set by 
clicking on a channel label to show only the selected channel. A further click on the label will show all 
channels again. To adjust vertical (amplitude) and horizontal (time) resolution, two sliders are implemented. 

 

​
 Figure 8: EEG Display Settings: vertical/horizontal resolution 

 



 

 

Figure 9: EEG Display with only one trace selected​
 

The vertical resolution can be set between 5uV…300uV / Div (5uV steps). The horizontal resolution can be 
set between 1sec…20sec / Div (1 sec steps). 

 

The EEG display can be set to scroll or to overlap mode. Use the overlap mode if the display is jerky or 
flickering. The selected mode is remembered through the file settings.xml. 

 

 

Figure 10: Oscilloscope Mode (overlap, scroll) 

 

ERPrec shows all EEG channels in referential (linked ears) Montage. 

4.2.2.​ EEG Filters 

The EEG Display uses three kind of filters: a Low Pass, a High Pass and a Notch filter. The filters can be 
modified in the Quick Launch Bar. 

 

 

Figure 11: Filter Settings 

 
Find the possible filter settings below. The default values are: HPF = 0.16 Hz, LPF = 30Hz, Notch = 50 Hz. 
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High Pass filter (HPF) Cut-Off frequency Options: 
0,16Hz, 0,32Hz, 0,53Hz, 1,6Hz, 5,3Hz  

Low Pass filter (LPF) Cut-Off frequency Options: 
15Hz, 30Hz, 50Hz, 70Hz 

Notch Filter Center-frequency (Bandwidth) Options: 
off 
50 Hz 
60 Hz 

 

 

NOTICE 

The selected Filter settings do only affect the EEG Display. If you do record your session - the 
filters do not have any influence – ERPrec will always record the raw, unfiltered EEG signal.  

 

 

4.2.3.​ Recording a Session 

To record a session, press the Record button in the Quick Launch Bar or select 'Record' in the main menu.  
 
 

 

 

 
The client selection window will appear in the right panel, asking you to choose a client. The left box will 
show the clients that are already saved in your system. You can either choose one of them or add a new 
client. Press ‘OK’ to confirm your choice. 
 
 



 

 

Figure 12: Choosing a client 

 
After choosing the client, its ID card will open up in a new window automatically.  
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Figure 13: Client ID card 

 
After filling in the entries, click on ‘Recording’ to proceed. This button is only active if the recording request 
has been made by selecting “Record” on the menu or by pressing the red “Record” button.  

 
The Recording Button in the control bar will light up after recording has started and a label in the upper right 
corner of the EEG Display saying ‘Recording’ appears. 
 
 

 
 

 
 
 

 

NOTICE 

You can start recording at any time during the session. ERPrec will always save the whole 
session! 
 
During EEG recording, you can adjust the Client information. It will be saved if recording is 
stopped. 

 

4.2.4.​ Labeling epochs during a recording 

ERPrec allows defining two kinds of labels manually during a recording: Eyes Opened and Eyes Closed. 

To mark the beginning of e.g. an Eyes Open epoch, click on the Eyes Open Button in the Quick Launch bar. 

 

 

Figure 14: Eyes open labelling 

 
The ‘Recording’ label in the upper right corner of the EEG Display will now change to ‘Eyes Open’ followed 
by the timer that shows the current duration of this epoch. 

To end the Eyes Open epoch, you can either click on the Eyes Open Button again or directly select another 
label (Eyes Closed). The recording label will change back to ‘Recording’ or show the Eyes Closed label 
correspondingly. 

 

 

 

 



 

 

4.2.5.​ How does ERPrec store a recorded session? 

ERPrec does save all recorded Sessions in a folder named after the chosen client. The file names are formed 
out of the session date, time, Recorded Conditions, and the client’s name. Refer to Section 5.5 for more 
details. 

Example: John Doe, recorded on November 13, 2013 at 13.20 o’clock, Eyes Opened - would be represented 
as follows: 

Folder name: \John Doe\ 

File name: \2013.11.13-13.20.00-EO-John Doe.xdfx 

 

NOTICE 

The client name is used to identify stored data 
●​Make sure that the client's name is written correctly 
●​Do not use characters that are not allowed to build file names such as /\:*?><| 
●​Numbers may be used for client identification for anonymity and HIPAA compliance 
 

 

We strongly recommend entering only anonymized patient data.  

By default – all client folders and files will be saved in a subfolder of your ERPrec Installation folder called 
‘Session’. To browse this folder, you can use the ERPrec main menu: File -> Open Client Folders. 

Section 5.6  shows how to change the default folder path for saving your client’s data. 

You can also show a list with all your clients and their recording history using: Files -> Show Client History. 
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Figure 15: Client History 

The client history window shows the clients found in the /Session folder on the left and the session files 
(.xdfx and .xdf) on the right. 

If no client information was entered, a session will be stored nevertheless. ERPrec will save the recording in 
the main session folder with the name “default”. So, if you want to store the session data after pressing Stop 
somewhere else, just create a copy from the default.xdf file in the desired location. The “default.xdf” file will 
be overwritten next time a session is started. 

4.2.6.​ How does ERPrec store a recorded session? 

Step Task Comment 

1 Press ‘Record’ New Session is started and the user is intended to recall or fill out a new client card 

2 Select condition During recording: Select EO, EC or Task (in right panel) 

 Case Task: The system will perform a self-calibration, followed by the practice test. To start, press 
<enter>. The practice test can be interrupted any time by pressing the key 's', which will 
lead to the start screen of the full CPT. Details in Section 4.3.  

3 Pause Session To pause, press the key 'p', to resume press <Enter> 

4 End of Session After the last trial, the recording will stop automatically and the file will be saved 

 

4.3.​ Starting an ERP Task 

ERP Tasks can be started using the ‘Task‘ tab in the Right Panel. The ERP Launcher will open up – showing all 
built-in ERP and own Tasks.  

Click on the icon of the ERP Task you want to start. 

 

 

 

 



 

 

 

NOTICE 

Selections in the task selection dialog will only be processed if the recording was started and 
a client was entered or selected. This shall avoid to accidentally forget to record the session. 
 

 

 

 

 

 

Figure 16: ERP / Task Launcher 

The ‘Task definition’ shows pre-sets for the selected task. The button ‘Practice Test’ can be used to override 
the suggested setting of the selected task. 

There are two basic kinds of Tasks: 

a)​ Precise ERP tasks. These are usually Go-Nogo tasks that require high timing precision. The use of 
the Sync Box is required.​
The task section will be represented by one fragment named after the task. 

b)​ Task scripts. These can be the same as (a) but also contain very long segments. The main difference 
to (a) is that there is no calibration and no practice test and that each trial will define a fragment in 
the EEG recording. 

 

For more details, refer to section "5.4 : Creating own Tasks" 

4.3.1.​ Automatic Self-Test 

As stated in Section 3.4 , prior to the start of an ERP session, an automated self-test will be performed to 
ensure valid timing conditions of the hardware. 
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After clicking on the ‘Start’ Button, the real-time engine will take over control of the PC. On the client 
monitor where the Sync-Box is mounted, the calibration square will start to blink in the lower right 
corner.  

On the clinician monitor, a self-test window will appear. The three bar displays shall enable the clinician 
to adjust the audio and video if they are not already ‘green’. 

The blue horizontal lines indicate the threshold that needs to be achieved to pass the test. The audio and 
video levels need to be above the threshold (large enough signal received by the Sync-Box) and the 
standard deviation (StdDev) needs to be below the threshold (jitter low enough). 

​  

 

Figure 17: Automatic Self-Test Display 

 
In the case of Figure 17, the audio and video signals are not in range. Only if all three bars are ‘green’, the 
self-test progress timer at the bottom of the chart will start to count for 15s. Only if all three conditions 
are met for 15s, the self-test will exit automatically and the ERP session can be started. If the self-test 
shall be stopped, the user needs to press ctrl-q which will also terminate the Session. 

The self-test window gives further information on the root cause if conditions are not met. These are 
explained in the troubleshoot table in Section 4.3.4. 

4.3.2.​ Practice Test 

If the button ‘Practice Test’ is pressed, the notification ‘Start with Practice’ with a green background will 
appear. The practice test shall help the client to get familiar to the ERP test procedure. 

The practice test performs 30 ERP trials for testing and will then ‘pause’ the session. By hitting <Enter>, the 
main Session starts.  

4.3.3.​ ERP Session 

After the self-test succeeded and, if selected, the practice test has been performed, the main task will start 
on the second monitor in full-screen mode, most likely in a paused state. 

After the clinician has introduced the procedure to the subject, the task can be started by hitting the Enter 
key on the keyboard. 



 

 

Figure 18: ERP Launcher 

 

The recording label in the upper right corner of your EEG Display will now change to the name of the 
selected Task, e.g. VCPT, followed by the timer that shows the current duration of this Task. 

In addition – for most Tasks a second label will appear – showing additional information about the current 
Trial of the Task. 

If your selected Tasks includes a client’s response – use the mouse that is part of the X23’s Sync-Box. If the 
mouse button was pressed (left, right or both) a little indication bar below the second ERP label will light up 
(yellow). 

 

 

Figure 19: ERP Info Boxes 

 

Note that mouse and keyboard are not available while the task engine is presenting the stimuli following the 
task script. Only a few entries are possible, namely "Enter" to start, "p" for pause, "s" to end the practice 
test and "ctrl-q" to terminate the stimulus presentation and end the recording. 

If it will ever become necessary to re-gain mouse and keyboard control without terminating the recording, 
the following procedure can be applied: 

-​ Press 'p' to pause the recording. Wait until the pause screen appears. 

-​ Press alt-tab to switch to the desired window. Now the real-time ERP engine will disappear from the 
second screen, but it will still be running.​
Now the computer can be used normally. 
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-​ To return to the Task presentation mode, click on the symbol of the ERP task engine software in the 
taskbar:​

 

-​ Press "Enter" to resume the task presentation 

The task engine also scales the visual part of the task according to the distance between patient and screen 
as well as the screen size, to fit the size and distance specified in the task: 

 

 

Figure 20: Screen adjustment 

 
Please verify that the values actual_screen_width and actual_screen_distance in the erp.xml file are 
correctly set to the physical width of your screen (actual_screen_width) and the distance between the 
patients’ head and the client screen (actual_screen_distance). Both measurements are to be given in 
centimeters. 

The task engine may display a warning in the top left corner of your screen stating that the screen is too 
small to display the task with the current settings. In this case, please move the patient closer to the screen 
and adjust the actual_screen_distance value in the erp.xml file, and then re-start the task.  

Note: 

If the actual_screen_distance value is set to zero (in the erp.xml or task.xml file), the re-scaling function is 
disabled. 

4.3.4.​ Troubleshooting Self-Test 

Problem Comment 

Audio below 
threshold 

Solution 1: 

The Sync-Box has two sockets for audio (refer to Section 6.1.2). One is used to 
connect the PC to the Sync-Box and the other is used to connect speakers. Please 
connect speakers or headphones to the second socket and check if the calibrating 
sound (‘beep’) is playing. 



 

Solution 2: 

Press alt-tab to gain control of the PC. Now check the volume settings in the 
Windows Task-bar on the lower right corner and increase it if needed. 

Solution 3: 

Windows sometimes changes to a different playback device. Make sure that the 
one is selected as standard where the audio jack is connected to. 

Video below 
threshold 

Solution 1: 

Check the monitor resolution of the client monitor. Check that the calibration 
rectangle appears and blinks on the lower right corner of the screen. 

Solution 2: 

Check that the Sync-Box is mounted correctly on the screen. It should be attached 
in front of the blinking rectangle. 

StdDev above 
threshold 

Solution 1: 

If the jitter of sound / video is too large, this might have the root cause in the 
missing VSync activation. Please make sure that it is turned on. 

Solution 2: 

Please check the monitor refresh rate. It should be set to 60 Hz. Lower settings 
could lead to a larger jitter. 

 

If none of the above solutions help, please contact the Support. 

If the conditions are met for 15s, the self-test terminates and the ERP session is ready to start. 

4.4.​ Using Replacement electrodes 

If you are using ERPrec in combination with the NeuroAmp/X23 device – you can use up to two replacement 
electrodes (usually named "Snap-In" or "Quick-Insert" electrodes). 

Connect the quick insert electrodes into the X1 or X2 plug on your X23 device first. 

Then open the X23 settings menu via the ERPrec main menu: Settings -> Quick-Insert-Electrode 

 

       

Figure 21: Setting replacement (quick-insert) electrodes 

 

After the selection there will be a red marking indicating that this selection has been made.  
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Figure 22: Marking when using replacement (quick-insert) electrodes 

 
You can now define which channel shall be replaced by the quick insert electrode. E.g. the replacement 
electrode in the example, connected to plug “X1”, replaces channel Fp1.  

 

NOTICE: This setting cannot be changed while recording a session! 

4.5.​ Combination Sensor 

ERPrec supports the "Combination Sensor", which does measure 

1)​ Heart rate 

2)​ Galvanic Skin Response 

3)​ Finger temperature 

at one finger. 

 

 



 

 

​
 

Figure 23: Connection of the combination sensor with the EEG NeuroAmp and menu selection 

 

To make it work it needs to be connected to the right-most connector of the EEG NeuroAmp(see Figure 
23) and needs to be enabled via the menu item Settings � Combination Sensor � Enable…. 

 

If enabled, each session recording will consist of two additional files: 

a)​ recording-bio.xdf 

b)​ recording-r-r.dat 

If the sensor is attached correctly to the finger, the graphs in the Right Panel will start to show the three 
physiological measures (see Figure 24).  

The small moving graphics right to the time axis dial shows the heart signal. If it is usable the green dot 
in the heart rate graph will flash with the heart rate and indicate heart rate measurement. 

The dotted lines in the heart rate window show the heart rate variability for the last 20 seconds 
(peak-peak value). 
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Figure 24: Graphs with Combination Sensor connected 

 

Figure 25 shows the controls for the time axis for the three graphs and the individual vertical axes. The 
vertical axes default to automatic scaling. In case you'd like to adjust the appearance of the graph, you 
may click on the "Auto" button to switch to manual adjustment. Then, the ^ and v buttons will adjust the 
vertical position of the graph, and the + and – button is vertical size. "Reset" will restore the original 
view. 

 

         

Figure 25: Dials for adjustment of the vertical and horizontal axes of the graphs 

 

The Combination Sensor includes a selection for the heart rate signal source. It can be rather read from 
the Combination Sensor device or by an external signal which is plugged into X1 of the X23 device. 



 

 
 

 

Figure 26: Combination Sensor Signal Source Selection 

 
 
If ‘HR by Combination Sensor’ is pressed, the signal will be taken by ECG (Ch1) and not from the 
Combination Sensor. In this case the Button changes to green and the Button on the right ‘Show ECG 
Window’ can be pressed which will open a larger window of the signal. 
 
 
The first diagram shows the heart rate which is now calculated out of the data (ECG) from Ch1 or Ch2. 
Data source can be selected by drop down menu. 
The raw ECG signal is shown in the lower diagram. 
The raw ECG data is recorded and can be used for analysis together with the recorded EEG or other 
bio-signals. 
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Figure 27: Combination Sensor HR by ECG Selection 

 



 

5.​ Advanced Functions 

Besides the basic functions which are used to perform ERP sessions, some advanced functions have been 
implemented to give the user more flexibility. 

5.1.​ Advanced Calibration 

The visual component of the task is precisely tied to the refresh / frame rate of the second screen. The audio 
component, however, is subject to Windows timing, i.e. jitter and limited precision. The real-time engine 
takes a number of measures to ensure maximum precision for the audio part. The resulting fixed delay 
needs to be calibrated at least once, preferably before every CPT recording session.  

So, in this step, we have to perform two important settings: 

a)​ Enable video frame sync 

b)​ Initial audio delay calibration 

Item (a) is a graphics adapter setting, usually found in the "3D" settings. Here, the "V-Sync" has to be 
enabled. 

 

 

 

An important note before we start with the audio calibration: 

The real-time engine comes with a limitation that impairs the usability in the current release: keyboard and 
mouse are taken over exclusively by the engine. 

To be able to pause a session and interact with other programs, follow these steps: 

-​ as long as calibration or ERP stimulus presentation is ongoing and visible, the computer does NOT react 
to any input. 

-​ if you want to pause a CPT, do this: press p 

-​ if you want to go to the other programs, press alt-tab. Now the computer can be used as usual 

-​ to go back to the CPT, press on the little round white icon in the task bar 

then, press <enter> to continue the CPT 

Why all this hassle? The reason is that the CPT presentation is super-precise and does not allow any user 
interaction while running. 

In case you need to cancel calibration or a CPT, then press ctrl-q (stops everything) 

 

 

The calibration can also be interrupted by these methods or stopped by ctrl-q, e.g. to adjust the 
standard-deviation threshold. 

This section gives details on the calibration process and shall be read in advance. A step-by-step guide of 
how to perform the initial calibration is given in Section 3.4. 

 

Figure 28 shows the audio calibration screen that can be accessed via the Settings -> Self-test set-up menu 
item. This dialog is meant to give access to detailed information about the calibration process, to allow for 
manual calibration and to set preliminary values for the decision thresholds of the system. 

This window is key for most initial calibration settings as well as observation of proper ERP timing. 

To start a measurement, press the Start button in the main window. This will also start the oscilloscopes in 
this calibration window. The "Reset Gain" button allows setting a higher sensitivity of the graph. 
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Figure 28: Timing set-up in calibration window 

 

An initial ERP calibration check is started by pressing "CAL Mode" and then "Start Engine in CAL Mode". 
Now, the stimulus monitor will turn white with the synchronization rectangle flashing behind the Sync-Box. 
Also, the calibration sound will be played. If everything is connected properly and the sound volume is high 
enough, then the two traces of the oscilloscope in the calibration screen (see Figure 28) will show these 
signals. They may have a delay, which then is measured and shown in the upper part of the window. 

Also, the two mouse buttons are shown by means of flashing squares. Check if the two mouse buttons 
deliver the signals as expected. 

User Settings in Timing set-up window (check red circles in Figure 28): 

●​ Audio and Video threshold: a number that makes the system recognize that the video sensor "sees" the 
flashing square and the audio sensor recognizes the calibration sound. The numbers "max" and "min" in 
the above fields show the detected values. A good value for the threshold is approximately half the 
distance between max and min.  

●​ StdDev: The system will determine a measurement for the delay as valid when the standard deviation of 
the measurements falls below the threshold set and stays there for at least 15 seconds. 5ms is a good 
default; increase the value if the system shows high jitter and the standard deviation does not stay below 
lower values. If 10ms is not sufficient, contact the manufacturer of the equipment as general Windows 
hard- and software configuration needs to be checked and improved. 

●​ Sync Square size: the black square that flashes behind the Sync-Box shall be large enough to affect the 
video sensor but so small that it cannot be seen by the subject. The relative size in % is shown in the 
upper middle part of the calibration screen. X- and Y-size can be adjusted in 5% steps. Note that the 
adjustment can only be done when the ERP engine is not shown. So, to gain control over the mouse, 
press alt-tab. Then adjust the sizes and return to the calibration function by pressing the round white 
icon in the Windows task bar. 

The two oscilloscopes in the dialog show the traces for the two sensors video and audio. In CPT mode they 
synchronize on the frames and show the individual frame codes. 

It is to be noted that the sound can be shifted only in increments of video frame time, i.e. the reciprocal 
value of the frame rate. Example: 60Hz frame rate allows to shift the sound in 16.7ms increments. As a 
result, the remaining error can be up to ±8.3ms. If the system jitter (see value "std-dev") is very low, a higher 
frame rate will improve precision. 

 

When all these basic settings are done and the traces show audio and video signals properly, then a first ERP 
measurement can be taken. For that, press the red record button in the main EEG window, create a client 



 

"Test" (or any other name), and start an ERP recording by pressing the "select" button next to the word 
"ERP" (also refer to the next section for details). Then, click on the calibration screen again to bring it to the 
foreground. Then, uncheck the "Practice Test" Box and click on VCPT to start the VCPT. 

First, the automatic calibration will start. The standard deviation will decline below 10ms, and 15 seconds 
later the delay value that has been determined, will be written to the erp.xml file and the VCPT start screen 
will be shown. Press Enter to start the VCPT. Now, the CPT will start and the traces will show the alignment 
of sound and image. 

 

 

Figure 29: Calibration dialog window during CPT 

 

Figure 29 shows the traces for a CPT trial. The first 100ms square-shape signal of the red video trace shows 
the first visual stimulus. This is followed by the time code that depicts the number of the trial, here #46 as 
shown in the upper part under "CPT Mode". The next item is the second stimulus, and here we do see a 
time-synchronous auditory stimulus. The smaller oscilloscope on the top right shows the time match 
between video and audio in higher resolution. Note also the amplitude modulation of the audio trace: the 
amplitude is frequency dependent, lower frequencies show lower amplitude. 

When the CPT is finished, the recording file will automatically be written and the system is resetted. 

 

To check the timing, go to "Help � Convert .XDF to .EEG w/ analysis", navigate to the folder "Session" and in 
there to the folder with the name that has been chosen above to store the session. Select the file with 
"VCPT" in the filename. 

Now, besides the conversion to the .eeg format, the file will be analyzed for timing of video and sound. The 
result shall look like shown in Figure 30, Figure 31 and Figure 32. 

The audio stimuli may show some jitter. However, they shall appear mostly between the two blue lines. If 
that is not the case, either the audio calibration was not good enough, or a fixed delay might be entered in 
erp.xml as explained earlier. 

The two video traces shall show no jitter at all. If that was the case, the V-Sync settings of the graphics 
adapter must be adapted. 

Figure 31 shows one single glitch, which might be of no concern. However, the measurement should be 
repeated if there are any doubts. 

Now, the system is ready for use. 
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Figure 30: Audio stimuli timing analysis 

 

 

Figure 31: Timing analysis of the first visual stimulus 

 

 

Figure 32: Timing analysis of the second visual stimulus 



 

5.2.​ Electrode Testing in ERPrec 

In order to acquire useful data from the electrodes, they need to be tested and validated. This section 
explains shortly the process of cleaning and testing, using the example of silver chloride (Ag/AgCl) 
electrodes. A comparison between electrodes in distilled water and sodium chloride is used to illustrate 
the impact on electrode properties. 

5.2.1.​ Test Preparation 

A bowl with distilled water and a bowl with sodium chloride is needed. 
 

 

Figure 33: Bowl with distilled water 

 

 

Figure 34: Bowl with sodium chloride (NaCl 0.9 %) 
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5.2.2.​ DC voltage Check 

ERPrec has a built-in DC voltage measurement and logging function. To write the DC voltages to a logfile you 
need to start a recording  

1)​ Press recording button 

2)​ Select: Electrode DC Voltages from the menu 

 

 

3)​ Results are shown in oscilloscope window: 

 

 

Figure 35: DC voltages in µV for electrodes put into distilled water 

The value of 120 µV in this case corresponds to a scaling from center to max of the window. The full 
range of the screen has 240 µV. The different electrode signals settle within a range of 
approximately 120 µV. 

 

Comparing this to the result for NaCl, there is a huge difference in voltage. Figure 36 shows a 
settling range of only 6 µV which is a very good result for a DC offset. 

By applying these measurements, electrode defects can be easily seen if compared to the other 
electrodes. 



 

 

Figure 36: DC voltages in µV for electrodes put into NaCl 

 

4)​ To finish the measurement, press the Stop button. Logfiles of the measurements are stored in the 
archives folder. 
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5.2.3.​ Impedance Check 

ERPrec has a built-in Impedance Check function. It can be started via the Quick Launch Bar or the main 
menu. 

 

 

Figure 37: Starting the Check Impedance mode 

 
This will open a new window as shown in Figure 38. 

The Impedance is colour coded as shown in the legend on the right-hand side. 

 

 

Figure 38: Check Impedance window for electrodes in distilled water 

 

The color of the impedances shows that values are far above 100 kOhm which indicates a poor contact area. 

When applying NaCl, the impedances will decrease to values well below 5 kOhm. 

 



 

 

 

Figure 39: Check Impedance window for electrodes in NaCl 

 

While measuring the Impedance the EEG input will be paused. To stop the Impedance measurement, you 
can either leave the window open and press the ‘Close’ Button in the upper left corner. Or you close the 
Check Impedance window – which will also stop the Impedance measurement and continue the EEG 
processing. 

5.2.4.​ Impedance Recording 

In addition to the impedance check where the values are presented on the screen, the impedances can be 
written to a logfile. This is useful to check the impedances over a longer timeframe. In order to log the 
impedances, the following steps have to be performed: 

1)​ Press recording button 

2)​ Select: Electrode Impedances from the menu 

 

 

3)​ Results are shown in oscilloscope window: 
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Figure 40: Impedances in kOhm for electrodes put into distilled water 

 

Figure 41: Impedances in kOhm for electrodes put into NaCl 

 

 

4)​ To finish the measurement, press the Stop button. Logfiles of the measurements are stored in the 
archives folder. 



 

 

5.3.​ Overvoltage Notice / Voltage measurement 

There is an overvoltage notice. The input range of the x23 and x39 is ±560mV. The channel label/button 
changes its color to yellow, if ±400mV is exceeded and to red with outside ±500mV. There is also a way to 
monitor the DC offset of all channels: 

Menu item Measurement -> Electrode Voltages will open a history graph that shows the average voltage for 
each electrode within the full range. The ± range can be modified and the distance from the middle line to 
top and bottom in Millivolts is shown in the bottom right corner. The time axis can also be adjusted.  

 

 

Figure 42: Overvoltage warning and DC offset graph 

5.4.​ Creating own Tasks 

All tasks are located in the folder "Tasks", which is a sub-folder of the ERPrec installation (i.e. typically 
"C:\Program Files (x86)\ERPrec"). 

Each task is defined by: 

a)​ an own folder, preferably with a descriptive folder name. ​
Example: Task "VCPT" is located in folder "vcpt": " C:\Program Files (x86)\ERPrec \Tasks\vcpt" 

b)​ a file "task.xml" (see sections below for details) 

c)​ a task definition file <taskname>.pro according to the PsyTask software 
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d)​ all files specified in (c). ​
Note: there are three possible file types: ​
- images, format jpg or bmp​
- sounds, format wav or ogg​
- videos, format avi (note: videos are not supported by PsyTask but by ERPrec) 

It is possible to have the task.xml point to another folder within the Tasks folder. This can be helpful when 
many similar experiments are designed which use the same resources. Then, all resources and all task 
definition files (.pro) can be located in one folder that the task.xml files of other folders point to. 

 

5.4.1.​ task.xml 

This file is needed for each task and resides in the respective task folder: Tasks\<task>\task.xml 

 

Structure: 

<!-- purpose: information about the task in the same folder --> 

<!-- task_number tells the software which task this is. Use a number between or equal 10 and 50 --> 
<Configuration> 

​ <name>VCPT</name> 

​ <task_number>1</task_number> 

​ <script>vcpt.pro</script> 

 ​ <script_location></script_location> 

​ <enable_practice_test>1</enable_practice_test> 

​ <suggest_auto_calibrate>1</suggest_auto_calibrate> 

 ​ <define_fragment>task</define_fragment> 

​ <stimulus_image_size_auto>1</stimulus_image_size_auto> 

​ <specified_screen_width>34</specified_screen_width> 

​ <specified_screen_distance>150</specified_screen_distance> 

​ <pause_aborts_trial>0</pause_aborts_trial>​  

</Configuration> 

Notes: 

●​ name: task name 

●​ script: name of the script file, which resides in the same folder. Written to erp.xml 

●​ script_location: if everything is in the same folder, this can be empty. If the .pro file and all resources 

are in another task folder, then its name is to be given here. Example: vcpt uses the same resources 

as acpt. Then, the vcpt.pro could be located in folder acpt, and script_location would be "acpt". 

●​ enable_practice_test: if 0, no practice test shall be done 

●​ suggest_auto_calibrate: if 0, no auto-calibration shall be done automatically. Can be done manually 

●​ define_fragment: task/trial: if task, then the fragment is named after <name>. If trial, then each trial 

makes a fragment 

●​ stimulus_image_size_auto: see chapter "Size of Stimulus Images". Read by task.exe 

●​ specified_screen_width: see chapter "Size of Stimulus Images". Read by task.exe 

●​ specified_screen_distance: see chapter "Size of Stimulus Images". Read by task.exe 

●​ pause_aborts_trial: transferred to erp.xml; see description there 

 

 



 

5.4.2.​ The *.pro file 

The *.PRO file is a file that defines all resources (Pictures, sounds and videos), all tasks as a sequence of 
those individual resources, and the actual task as a sequence of those trials. The syntax for these task 
scripts can take a little bit of getting used to, but it is pretty straight forward if you take the time to learn 
it once. 
The task scripts are strictly command based, meaning that each line is exactly one instruction. Below is a 
guide of how to assemble a task script. 
 
First things first, the task must be given a name. This is done with the TaskName command: 
 

​ TaskName "MyTask" 

 

Following that, the stimuli must be defined. The stimuli list begins with the command StimuliList and 
ends with the command EndStimuli. Between those commands, the stimuli are defined. The commands 
for this follow the syntax [stimulus type] [stimulus name] [relative file path]. The following stimulus types 
are supported: 

●​ Image 
●​ Sound 
●​ Video 

 
It is important to make sure that neither the stimulus name nor the file path include any spaces. Also 
make sure to indent the Image, Sound and Video commands with two spaces. For example, a stimuli list 
could look as follows: 
 

​ StimuliList 
​  Image MyImage1 image1.png 
​  Image MyImage2 image2.png 
​  Sound MySound sound.wav 
​  Video MyVideo video.avi 
​ EndStimuli 

 

After this, the trials that are to be displayed later are to be defined. A trial definition begins with the 
command Trial [trial name] [trial run time] and ends with the command EndTrial. Between those, the 
stimuli are called with the syntax [stimulus name] [start] [end]. The times are given in milliseconds. The 
program has a resolution of 50 milliseconds. An example of a trial definition would be: 

 

​ Trial MyTrial1 3000 
​  MyImage1 100 600 
​  MySound 100 600 
​  MyImage2 2400 2900 
​ EndTrial 

Similar to the stimuli list, the commands to call a stimulus within a trial are preceded by two spaces. 

 
Following this is the definition of the actual sequence. The beginning of the sequence definition is 
marked by the command PsyTest [horizontal resolution]x[vertical resolution]x[color depth] [image 
positioning] [background color] and is ended by the command EndTest. Between these commands, the 
trials defined above can be called. Additionally, the following commands are available: 

 
●​ ShowPicture [stimulus name]: Shows a stimulus, until a ‘Start’ or ‘Resume’ is received from 

cpt_control.xml. 
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●​ SetBackground [stimulus name]: Sets a background image, which is shown behind stimuli and 
between stimuli. 

●​ Wait [time in ms]: Adds a wait time. During this wait time, the framerate is sent over the screen 
twice, once immediately and once after one and a half seconds. The minimum wait time is 3000 
milliseconds. 

●​ Pause: Pauses the sequence and displays the last stimulus shown via ShowPicture, until a ‘Start’ 
or ‘Resume’ is received from cpt_control.xml. 

 
The syntax for calling a trial is [trial name] [wait time] [trial type]. The wait time is added following the 
trial, and the trial type is simply a number defining what type of trial it is. It is important to note that 
color depth, image positioning and background color are currently not supported. An example of a short 
sequence is: 
 

​ PsyTask 640x480xTrueColor LeftTop 15 
​  ShowPicture MyImage1 
​  SetBackground MyImage2 
​  MyTrial1 100 1 
​  MyTrial2 100 2 
​  MyTrial3 100 3 
​  MyTrial1 100 1 
​ EndTest 

​
After this, the response processing must be defined. The task.exe does not require or consider this, but it 
is required to process the input the patient has provided. 
 
This is begun with the keyword ResponseProcessing and ends with the keyword EndProcessing. Between 
those keywords lays the definition of how the user responses are to be evaluated. This follows the syntax 
"[Name]" [Stimulus Number] [Minimum Latency] [Maximum Latency] [Key 1] [Type 1] [Key 2] [Type 2] 
[Label 1] [Label 2]. These values mean the following: 

 
●​ Name: The name of the marker to be placed 
●​ Stimulus Number: The stimulus number within the trial according to which the measurement is 

to be made (i.e. 1 for first stimulus, 2 for 2nd stimulus, 3 for 3rd, etc.) 
●​ Minimum latency: The minimum allowed response time, before which any input is ignored 
●​ Maximum latency: The maximum allowed response time, after which any input is ignored 
●​ Key 1: Key or mouse button that is used for the “first” response 
●​ Type 1: Keyword that defines the “first” response 
●​ Key 2: Key or mouse button that is used for the “second” response 
●​ Type 2: Keyword that defines the “second” response 
●​ Label 1, Label 2: Trial labels, connecting the trials to the processing commands  



 

The keys can be one of the following: 
●​ None: Not used 
●​ VK_RIGHT: Right arrow 
●​ VK_LEFT: Left arrow 
●​ VK_UP: Up arrow 
●​ VK_DOWN: Down arrow 
●​ VK_SPACE: Space bar 
●​ MOUSE_RIGHT: Right mouse button 
●​ MOUSE_LEFT: Left mouse button 

 
The type can be any of the following: 

●​ None: Not used 
●​ Press: Requires the user to press a button 
●​ Skip: Specifically requires the user not to press the button 

 
Response processing could look as follows, for example: 
 

​ ResponseProcessing 
​  "Go" 2 100 1000 MOUSE_LEFT Press None 1 
​  "Nogo1" 2 100 1000 MOUSE_LEFT Skip None None 2 
​  "Nogo2" 2 100 1000 MOUSE_LEFT Skip None None 3 
​ EndProcessing 

​
All tasks are defined in a *.PRO file which defines all resources and trials, as well as the entire task as a 
sequence of trials. 

5.4.3.​ Fragments 

Fragments and trials are shown and stored at various places 

a)​ upper right corner of EEG window 

b)​ bottom of EEG window: String containing all fragments that have been recorded 

c)​ file name: contains the string from (b) 

d)​ annotations in the EEG recording (XDF file) 

 

(a) shows the task name, followed by either "Practice" or the total time elapsed. 

Figure 43 shows the actual trial, the total trial number and the name of the actual trial. 

 

    

Figure 43: Task and trial displays 

            

Note that usually the name of the trial as defined in the .pro file will be shown. For some standard tasks 
such as the VCPT, the trial type will be shown as in the screenshots in Figure 43. 

 

(b) and (c): String representing the recorded fragments: 
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This was implemented to reflect manually initiated fragments in the file name for easier recognition later. 
This string can contain: 

 

-​ "EO" 

-​ "EC" 

-​ "<name of the task run by the task engine>" 

 

The task name is defined in the task.xml file. 

Over time, more and even user-defined fragments may be added. 

 

(d) Annotations: Fragments can be defined in two ways: 

1)​ by the task -> the task name defines the fragment. No matter what happens in the task, 
there is only one fragment from the beginning to the end of the task 

2)​ by the trial -> each trial within a task defines a fragment. This mode is meant to be used 
for experiments the sequence of which is defined by the .pro file. Each segment in there is 
a trial and will define a fragment with the name of this segment. 

This mode is defined by tag <define_fragment> in task.xml (can be "task" or "trial"). 

5.5.​ Recording of Sessions, File Formats 

The session is recorded in one single file: 
<YYYY.MM.DD>-<hh.mm.ss>-<taskname(s)-<clientname>.xdfx 
The xdfx file format is basically a zip folder that contains all recorded files, which are: 
 

●​ recording.xdf: EEG recording in XDF format 

●​ task.xml: task description, only present if a task was run 

●​ <task>.pro: task control file, only present if a task was run 

●​ recording-bio.xdf: bio sensor data, only present if Combination Sensor is enabled 

●​ recording-r-r.dat: R-R intervals in ms, only present if Combination Sensor is enabled 

●​ subject.xml: client data file 

●​ session.xml: session information 

●​ delay.log: logfile with information on calibration results 

5.6.​ Change Default Folder Path for client Data 

When recording sessions, the session data is stored in a folder named after the client. The path to the 
session folder can be set via the main menu: Settings -> Set Session Folder Path. A dialog window appears 
and allows selecting the path by browsing the folders. The default path is dependent of your ERPrec 
Installation path. Usually that is: 

 “C:\Program Files (x86)\ERPrec\Session” 

 



 

             

 

Figure 44: Session Folder Path Setting 

5.7.​ Reset 

In case you experience a complete hang-up of the software, you can reset ERPrec by selecting 'Reset' in the 
Settings menu:  

 

Figure 45: Resetting ERPrec 
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5.8.​ Check Data Transmission 

Proper signal transmission from the NeuroAmp/x23/x39 to ERPrec as well as real-time signal processing in 
ERPrec is crucial for a reliable running software. There are two indicators in the menu “Help -> NeuroAmp 
Information” that allow to check for proper signal transmission and processing: 

 

 

Sync Errors:  

This number should be 0. This field shows whether data packets have been lost between the EEG NeuroAmp ​
and ERPrec. Every time a data packet is lost the counter counts up. Occasional errors are not cause for concern, however if 
you see the counter going up fast during a session, check the serial or USB cable and make sure that no other processing 
intensive software is running. Contact us if you are not sure what to do. 

Processing Errors:  

This number should be 0. This field shows if data packets have been lost in the internal processing of ERPrec. Every time da
is lost, the counter for processing errors counts up. Occasional errors are not concerning, however if you see the counter 
going up fast during a session, make sure that no other processing intensive software is running. Contact us if you are not 
sure what to do. 

 

Figure 46: Signal transmission and - processing quality control information 

 

5.9.​ Micro Markers  

With firmware version 2.6.0, the EEG NeuroAmp provides a feature which allows adding synchronous 
markers on all channels. These markers can be used later to verify end-to-end timing accuracy from source 
to the last analysis step.  

From converter v.38 on there is a log file with information about timing accuracy with each conversion. 

5.10.​ Converter 

ERPrec stores all EEG/ERP recordings loss-free with the full 24-bit and full-bandwidth resolution in the XDF 
format. A built-in converter software allows for transferring the recordings into the WinEEG / HBIdb 
software format ".EEG".  

The converter requires the MATLAB runtime environment, which is not part of the installer package but can 
be obtained from the manufacturer of this software. It is to be noted that a different version is needed for 
32- or 64-bit Windows operating systems. 

Once the MATLAB runtime is installed, the converter can be invoked from the ERPrec menu "File".  

NOTE: when starting the first time, it may take a minute or two until the dialog box opens to select the file 
to be converted. 

There are two more ways to open the converter: via the Help menu there is an option to run a timing 
analysis and another one to convert applying an adjustment for optimum compatibility with the HBI 
database software. Users who intend to do analysis with the HBI database software are advised to use this 
option to convert the files. Users who want to use the HBI report service or do other analysis shall use the 
standard invocation via the "File" menu. 

5.11.​ Annotations over TCP/IP Interface 

In ERPrec, it is possible to send annotations over a TCP/IP interface. 
These will be saved as fragments, similar to „EO“ or „EC“, and will be shown e.g. in the .eeg data format.  
 
 
 



 

5.11.1.​ Activation 

To activate the TCP/IP connection, it needs to be enabled in the Settings-Network Annotations menu. As 
soon as a recording is started, this menu item is deactivated. Selection can only be made in „Stop“ state 
of ERPrec. 
 
 

 

Figure 49: TCP/IP Interface activation 

 
 
 
The setting is stored and will be set accordingly for the next start of ERPrec. 
As soon as the connection is enabled, this is shown in the bottom part of the ERPrec window: 
 
 

 

Figure 50: Notification for enabled TCP/IP interface 

 
 
 
If an annotation is set over this interface during a recording, this will be shown together with the 
corresponding session time stamp: 
 

 

Figure 51: Network Annotation with session time stamp 

5.11.2.​ Interface 

To establish a TCP/IP connection to ERPrec, the following needs to be met: 
 

1.​ Start ERPrec recording  � opens the TCP/IP interface 
2.​ Software, from where annotations shall be sent: 

a.​ Establish TCP connection on Port 4012 
b.​ Data will be received as Bytes and converted to ASCII within ERPrec 
c.​ Maximum length per Annotation is 41 Byte 
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5.11.3.​ Example: Annotations from Matlab script 

Usually, annotations are sent as strings. Still, the data needs to be sent as Bytes and the conversion to 
„Text“ is performed in ERPrec. The following example script shows the communication from Matlab. 
 
ip='192.168.2.109'; 
port = 4012; 
t = tcpclient(ip, port); 
 
Where „ip“ is the IP address from the PCs, where ERPrec is running. 
 
After establishing the connection, the tcpclient object will be shown with the following properties: 
 
t =  
 
  tcpclient with properties: 
 
           Address: '192.168.2.109' 
              Port: 4012 
           Timeout: 10 
    BytesAvailable: 0 
 

The transfer with „tcpclient“ needs to be done as uint8. To send a word or text as annotation, one needs to 
convert each letter to uint8 format. The following code performs this operation: 

name = 'Hallo'; 
data = uint8(name) 
write(t, data) 
 

The word „Hallo“ will be send as: 

data = 

 

   72   97  108  108  111 

 

In ERPrec, the data is received correctly and converted to string using ascii table: 

 

5.11.4.​ Annotations over TCP/IP in WinEEG Format 

The example script from above was used to send various annotations  („Start Block x“) during a QEEG 
recording. The annotations are correctly shown in the WinEEG Format: 
 



 

 

Figure 52: TCP/IP Annotations in WinEEG Format 
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6.​ Decommissioning/ Deinstallation 

To uninstall ERPrec from your system, you can use one of the two methods described below: 

Method 1: Windows Settings (see Figure 53) 

1.​ Open the Windows Start Menu and navigate to Settings. 
2.​ Go to Apps > Installed Apps (or Apps & Features). 
3.​ Locate ERPrec in the list, click the three dots (or the app entry), and select Uninstall. 

 

Figure 53: Locate the app in Settings->Apps->Installed app to uninstall it 

Method 2: Direct Uninstallation (see Figure 54 to 56) 

Alternatively, you can run the uninstaller directly from the application directory: 

1.​ Navigate to the ERPrec installation folder on your hard drive. 
2.​ Locate and run the file named unins000.exe. 
3.​ Follow the on-screen prompts to complete the process. 

 
 

Figure 54: The uninstaller unins000.exe can be started directly from the ERPrec folder 



 

 

Figure 55: Uninstallation  

 

Figure 56: Confirming a successful uninstallation 

Manual Cleanup Required 

Please be aware that the standard uninstallation process does not remove all data to prevent 
accidental loss of settings or logs. After the uninstaller has finished, some files and directories 
will remain in the ERPrec folder. 

To completely remove the software, you must manually delete the following items: 

●​ The Session folder (contains client data). 
●​ The Config folder (contains your custom configurations). 
●​ Any remaining log files or sub-folders within the main directory. 

Once these are deleted, you can safely remove the ERPrec folder itself.  
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7.​ Technical Data 

Signal processing / 
EEG Display 

Traces 19 (10-20-System), 31 or 1 (selectable) 

Filters High Pass, Low Pass, Notch 

High Pass filter 2nd Order Butterworth 
Cut-Off frequency Options: 
0,16Hz, 0,32Hz, 0,53Hz, 1,6Hz, 5,3Hz  

Low Pass filter 2nd Order Butterworth 
Cut-Off frequency Options: 
15Hz, 30Hz, 50Hz, 70Hz 

Notch Filter 2nd Order Butterworth 
Center-frequency (Bandwidth) Options: 
off 
50 Hz 
60 Hz 

 Horizontal Resolution Adjustable (1sec…20sec / Div), 1sec steps 

 Vertical Resolution Adjustable (5uV…300uV / Div), 5uV steps 

 
 
 

Signal sources EEG NeuroAmp/x23/x39/Sync-Box; data interface (EEG NeuroAmp): USB 

 
 
 

Signal displays Oscilloscope, high-pass 
filtered raw EEG 

Horizontal span: 10s, vertical span: adjustable 

 
 
 

Warning Displays Synchronization loss error counter 

Processing data loss error counter 

 
 
 

File operations Modes Write 

File format XDF 

File name <date>-<time>-<conditions>-<client name>.xdf 

File location Default: <ERPrec>\session\<client name>\ 
Can be defined by user 

 
 
 

ERP Tasks Synchronization Sensors - EEG NeuroAmp/Sync-Box 

 Built-In Tasks VCPT, ACPT, ECPT, TOVA, MMN, Math, Reading 

 

 

 

 

 

 

 



 

 
 

8.​ Warranty 

The software is guaranteed to function as intended for one year from the date of initial installation. This 
includes the provision of security updates and error rectification free of charge. 

Warranty Claims:  

In the event of a software malfunction, contact our technical support. We will repair or replace the 
affected software components if a defect is confirmed within the warranty period. 

Exclusions: 

This warranty does not apply to issues caused by: 

●​ External Factors: Changes to hardware, operating systems, or network configurations. 
●​ Misuse: Unauthorized modifications or "hacks" to the software. 
●​ Environment: Incompatibility with third-party environments. 

We accept no liability for consequential damages, such as lost profit, downtime, or data loss, resulting 
from a breach of this warranty. 
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